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About this guide

Purpose
This guide is intended to help you quickly learn to use ProteinAssist" Software to
analyze your TagMan® Protein Assays data.
* You can use this guide as a reference.
* You can also follow the structured tutorial exercises using the example data files
provided with the software. See “Tutorial overview” on page 17.
Prerequisites

This guide assumes that you have working knowledge of:

* Procedures for performing TagMan Protein Assays.
* Microsoft® Windows® XP operating system.

¢ Instrument operation and system software for your Real-Time PCR System.

ProteinAssist™ Software Getting Started Guide 5
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CHAPTER 1

Install ProteinAssist’" Software

System requirements

Table 1 Hardware configuration and operating system requirements

Minimum hardware configuration Recommended hardware configuration
Intel CPU, 2.4 GHz Intel CPU, 3.0 GHz
Available hard disk space: 1 GB Available hard disk space: 20 GB
Memory: 1 GB Memory: 2 GB
Screen resolution: 1024 X 768 pixels Screen resolution: 1280 X 1024 pixels

Operating System: Windows® XP 32-bit ([recommended Service Pack 3)

Note: ProteinAssist’ Software has not been verified on system configurations other
than the two listed in Table 1.

Install the software

1. Go to www.appliedbiosystems.com/proteinassist, and follow the prompts for
downloading the ProteinAssist™ Software.

2. Navigate to the folder containing the downloaded installer, and double-click
setup.exe to start the installation.

3. Follow the prompts to install the ProteinAssist Software in the desired location.

Note: If you are re-installing or upgrading ProteinAssist"" Software, you must
first uninstall the software (see page 8). The uninstall process protects existing
data.

4. (Optional) If you are re-installing or upgrading ProteinAssist"" Software:

¢ Install the software on the same drive on which the previous version was
installed.

* You will be prompted to restore any data from the previous version of the
software. Click Yes.

¢ The first time you open a study that was saved in a previous version of the
software, you will be prompted to re-analyze the study. Click OK.

Information

& ‘fou are opening a study saved from a previous version,
\\2 Opening this study will upgrade it ko the current version,
Re-analysis is required,

ProteinAssist™ Software Getting Started Guide 7
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1 Chapter 1 Install ProteinAssist™ Software
Uninstall ProteinAssist™ Software

Uninstall ProteinAssist™ Software

Uninstall the
software

(Optional) Save
data before an
uninstall

1. Open Windows Control Panel » Add or Remove Programs.

2. Select ProteinAssist'™ Software, click Change/Remove, and follow the prompts to
uninstall the software.

Note: The uninstall process protects existing data in the background.

If desired, you can use the Transfer out Study tool to save your ProteinAssist Software
studies outside of the application workspace before you uninstall the software (refer
also to “Transfer out a study” on page 55):

1. In the Home window, select a study, and click Transfer out Study.

2. Navigate to the desired folder, enter a name for the study file (*.1as), then click
Save.

3. Follow “Transfer a study into ProteinAssist’" Software” on page 19 to restore the
saved files, if necessary.

ProteinAssist™ Software Getting Started Guide
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Overview

CHAPTER 2

Set up ProteinAssist’ Software

After ProteinAssist’" Software is installed, set up the software:

e Familiarize yourself with how data is managed in the ProteinAssist’ Software
(this page), and the software workflow (page 11)

* Set the default file save location (page 11) and adjust the default study settings, if
necessary (page 12)

¢ Familiarize yourself with key toolbars and software conventions (page 14)

About ProteinAssist™ Software

About studies,
experiment files,
and samples

ProteinAssist™ Software performs relative quantification calculations with your
TagMan® Protein Assay Ct data. TagMan Protein Assays enable detection and relative
quantification of protein targets using an adapted form of PLA™, a proximity ligation
assay technology, in combination with real-time PCR. See Appendix A on page 61 for
information about TagMan Protein Assays, key differences in data analysis of TagMan
Protein Assays and traditional real-time PCR, and the algorithm used to calculate fold
change (relative quantification).

In the ProteinAssist Software, data is managed as a study.

¢ A study is a collection of TagMan Protein Assay experiment files.

* An experiment file contains TagMan Protein Assay data from a single reaction
plate.

— The plate must be from one of the Applied Biosystems real-time PCR
systems listed in Table 2 on page 10.

— Each experiment file must have a unique file name.

¢ A sample includes all the wells in a dilution series of one lysate. For detailed
information, refer to TagMan® Protein Assays Sample Prep and Assay Protocol
(PN 4449283).

A study allows you to analyze data from multiple reaction plates. Optionally, one
reference sample can be used in analysis of all the experiment files for that TaqgMan
Protein Assay.

We recommend analysing studies with no more than two hundred 96- or 384-well
plates.

ProteinAssist™ Software Getting Started Guide 9



2 Chapter 2 Set up ProteinAssist™ Software
About ProteinAssist™ Software

Compatible real-
time PCR systems

10

Figure 1 shows an example TagMan Protein Assay plate layout for the dilution series
for 8 different lysates, with sample names and task assignments that could be assigned
in the software. With the plate setups shown in Figure 1, the C data for each plate is
imported into ProteinAssist Software as an experiment file. Sample 1 is the reference
sample for samples 2 through 8. The data from both plates is analysed as a single
study, and the Reference Use would be set to Per Study.

Figure 1 TagMan® Protein Assays: samples and task assignments

TagMan® Protein Assay

Task: Reference Unknown Unknown Unknown Unknown Unknown Unknown Unknown
Sample: Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample 6 Sample 7 Sample 8
000000000000 000000000000
000000000000 000000000000
- 000000 00OGOCGOO | X X JOXOXOX X X XOXOXW
el o000 0000000 (000000000000
00000009000 Q00000000000
Q00000000000 Q000000 OOOOO
Y ©OOO0COO0OO0O0O00O0O0O0O O0OO0O0OOOOOOOOO
Task NPC (O O O O OO OO OO el QOOOOO0O000O0O0 0O
Table 2 Compatible real-time PCR systems and plate files
Real-time PCR system Plate file
. System software
(Fast system recommended) extension
7500 Fast system * eds, *.txt 7500 Software v2.0.2, v2.0.3, and v2.0.4
*.csv SDS Software v1.4
7900HT/7900HT Fast system * txt SDS Software v2.3 Patch A, B, C
e Standard 96-Well Block
Module
e 384-Well Block Module
e Fast 96-Well Block Module
StepOnePlus™ system ' *.eds, *.txt StepOne™ Software v2.1
ViiA™ 7 ' * eds, *.txt ViiA™ 7 Software v1.0 RUO only
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Chapter 2
ProteinAssist™ Software Workflow

ProteinAssist™ Software Workflow

Set up a study (Chapter 3)

Launch a study

|

Set required study properties: Study Name, Reference Use

|

Set up the experiment files within a study (Chapter 4)

Import TagMan® Protein Assay plate files

1 ARAAAAR
EARERERE
fss T YT

Assi ired well ies: Sample, Assay, Task, Input Quanti Raimmns

ssign required well properties: Sample, Assay, Task, Input Quantity R AREEEE
1 Loty
3 T e
Analyze the study (Chapter 5)
Review data for each dilution series ,

l Pty ;:.’_-;:'7-;

Adjust analysis settings (optional) and omit outliers, if desired

1 | II.;- Il

View fold change results as a bar graph or heat map

Save or export study data (Chapter 6)

Set default save location

To set the default location for saving exported data and study files:

1. In the Home window, select Tools » Preferences » General tab.

ProteinAssist™ Software Getting Started Guide



Chapter 2 Set up ProteinAssist™ Software

(Optional] Adjust study preferences

2. Select from the following options:

User-defined location: Click Browse to navigate to your selected folder.

Last-accessed location: The folder you last visited, in or out of the
application.

# pPreferences

Wy Set the default save location and other study properties in this windaw:.

ﬁ Study Preferences

Default Home Location:

|C:IAppIied Eiosysterns/Protein Assist SoftwareilUser Data | ’ Browse ]

(O Last-accessed location

(Optional) Adjust study preferences

12

Adjust study preferences to match study parameters you use most commonly.

1. In the Home window, select Tools » Preferences » Study Preferences tab.

zl

Wy Set the default save location and other study properties in this windaw.

General

Study Properties

Input Quantity Urit: I Decimal Defirmiter; ¢ Comma ()

(Example: cellsfwell or pgfmL) & Period {.)
Reference Use

" per Plate: Each assay must have a reference sample in the same plate,

@& Per Study: Each assay must have one reference sample per study; it can be in a separate

plate from the unknown or NPC samples.

Plate Settings

Dilution:  [2.00

show well Fields

Sample: W Input Quantity: Custom 1 T
bssay: W Group: [ Custom 20 [
Task: W Treatment: ™ Custom 3: T

Comments: [~
Default Analysis Settings
Detection Parameters
Low 3 High
Qutlier Sensitivity:
(standard dewviations) | | |
4 3 2
Lot 20 High

Linear Range Sensitivity:
|
100 73 S0 23 0

Default Quantification Threshold:  |2.00

oK Cancel

2. Adjust the study preferences, if necessary, using the information in Table 3 on
page 13.

ProteinAssist™ Software Getting Started Guide



Chapter 2 2
(Optional] Adjust study preferences

Setting Purpose Action or comments

Table 3 Study Preferences

Input Quantity Unit | Sets the units to be displayed in the data | Enter the units of the input quantities for the samples.

(optional setting) plots and at other points in the software. Default is blank.

The units can be set for individual studies. See

page 19.

Decimal Delimiter Sets the format of numerical values in Select period () or a comma (,) as the decimal
exported *.txt files. delimiter.

Default is period.

Reference Use Sets how the reference sample is used for | Choose a setting:
data analysis. ¢ Per Plate: Each assay must have a reference
sample assigned in the same plate.

e Per Study: Each assay must have a reference
sample assigned, but it can be in a different plate
within the same study.

Default is Per Study.

The setting can be changed for individual studies.

Dilution Sets the default dilution factor for the Enter the dilution factor most commonly used in your
Dilution tool in the Plate Layout tab. TagMan® Protein Assays.

(This tool allows you to easily assign input | Default value is 2.0.
quantities to a dilution series by a click-

. The dilution factor can be adjusted for individual
and-drag function.)

experiment files in the Plate Layout tab. See page 33.

Show Well Fields Sets the well fields (properties) to be Check the desired well fields.
displayed in the Plate Layout screen and

the Well Editor Default setting is Sample, Assay, Task and Input

Quantity, which are properties required for analysis.

The setting can be adjusted for individual studies. See
page 26.

Outlier Detection Sets the sensitivity of the software for Set the standard deviations from the average of
flagging outlier wells in the Plate Layout | replicate Cy values.
and the Well Table.

The lower the sensitivity, the more an
individual well must deviate from its

Default setting is 3.

The setting can be adjusted for an individual study.

. . See page 51.
replicate group’s average Cy value to be
named an outlier. Note: Flagged outliers are included in data analysis
unless manually excluded using the Omit tool. See
page 51.

ProteinAssist™ Software Getting Started Guide 13



2 Chapter 2 Set up ProteinAssist™ Software
Key toolbars and software conventions

Setting Purpose Action or comments

Linear Range Determines the sensitivity of the linear Adjust the sensitivity of the algorithm with the slide

Detection range algorithm that evaluates whether tool:
or not to include a data point by  High sensitivity: A replicate group is considered
determining how far a given value part of the linear range only if its average ACy value
deviates from the regression line. falls very close to the regression line of an initial
The sensitivity of the linear range set of two or three replicate groups chosen by the
algorithm is the degree to which the algorithm.
average ACy values of replicate groups * Low sensitivity: A replicate group can be
must be colinear. considered part of the linear range even though its

average ACy value deviates significantly from the
regression line of an initial set of two or three
replicate groups chosen by the algorithm.

The regression line of the data within the
linear range of the dilution curve for each
sample is automatically computed when
you click Analysis in the Analysis toolbar. | Default setting is 20.

For more information, see “Linear range | The setting can be adjusted for an individual study.

algorithm™ on page 62. See page 49.
Quantification The Quantification Threshold is a factor Default value is 2.0. See Appendix B on page 67 for
Threshold used in the fold change algorithm. See information on adjusting the Quantification Threshold.

“Fold change algorithm” on page 62.

Key toolbars and software conventions

Home window The Home window displays upon launching ProteinAssist Software. Use the home
toolbar window tools to:

* Create new studies, open existing studies, or transfer a study file into the
application workspace (page 19).

e Transfer studies out of the application workspace in a ProteinAssist Software-
compatible format (page 55).

* Delete studies from the application workspace (page 56).

Figure 2 Home window toolbar
:_i Create Study @% Open Study :E* Transfer out Study :_ié Transfer in Study :__% Delete Study

Study workflow Use the study workflow menu to access the Setup, Analysis, and Export functions of
menu the software for a given study (Figure 3 on page 15).
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Chapter 2 2

Key toolbars and software conventions

Figure 3 Key toolbars and menus

¥ ProteinAssist™ Software Version 1.1

Fie Analysis Tooks Help

Study analysis toolbar T 18k sove [Spsaveas (Sle dose | P s arlyss settings | € Help |
Experiments toolbar - < import = Remove g Gonerte Pote Tempite 3 o Pite Tempite [y Bt [E2)pite sctup e
£ setup
File Name Barcode #ofWells #of Samples Instrument Type Block Type. Run Condition Date Added
roperis [ocrs \ s s [stoponepis™ st | 95 [ [zoi005:10 1126
= i o s SteponePis™ oyt |56 T omnoe10 1120
Eperment Fies
Tz i Toe s Steponeptus™ st |08 The [ omooe10 120
Study workflow menu —f #*¥*
A
Saneles Plate Setup: LIN28
Samples

|| [srow in wels + select wels ~ [BE view Legend oiuton{3.00 | ] Omit g Save as Image o Clear [ b=

T+ [ 2 [ 5 [ + [ 5 [ & [ 7 [ & [ 5 [ % [ w [ = |
sample 1 sample 1 samu\e 1 samu\e 2 samu\e 2 sample2 sample3 sample3 sample3 sampled4  sampled  sample 4
& es [fie . s . &l 2s ElhNzs EIhvzs B hivzs & &l &l
sample 1 sample 1 samu\e ] samu\e 2 samu\e 2 sample2 sample3 sample3 sample3 sampled4 sampled  sample 4

® it v v v CesCn Ve Caness fines CAnes s ivines

gy sample 1 gy ssmu\e 2> samge : ampez sampled smoe3 sped sample 4 ssmu\e 4 ssmu\e :
.. 55 M .. 55 576l 55 m .. 55 55, M m
. s [T [ za. o5 [ za. 2o [HNze RN 2B e (TR (1] 5
CIMihocTs/ v ssmu\e 7' Sampe 1 ssmu\e T Sanpe 2 g2 ged gk <mple s ssmu\e 3 Sampled ssmu\e : ssmu\e ]
. .. 15,68 .. 15,68l

I, I
Tasks ———— 68 Mga. ho (1] Az (IR za. za. 2aﬂmmaﬂ 2aﬂ ho ([ Ane: [ za.

G i s il e b Hilic: G s [ e [

Samples, Assays, and
Tasks lists

[mI Ll e e r70 %0 a0 n o s eriom AR Cria0 60
O ssmu\e i moel smoel ssmu\e : ez ks ssmu\e E =ndas omies =gas ies =ghg
i M i Cinibes s Tines Cibes e | s e
g [IALes [hLoes [hnes [Aies Az [ 2aﬂ 2aﬂ cs [Hives [ za. A
well Explorer = ||[ Gomged e’ sanged Cpko SR> smpe? capes s e 3 Sanpk3 sample J ssmp\e 4 ssmp\e 4

I Dﬁm Il.. 0.6 Il.. 0.6 Il.. 0.6 I, Dﬁm Il.. 0.6 I Dﬁ n‘ m
. e [ Hes (TR [0 nEhes [TIhCbes 1 nes [ 2aﬂ hes s (1] za. hes [es

wel E -
Sarmple (%) £ an i ) aliue el D2 EHD( EHD( o ) algwe el ) celfvet el 0 celgivel b cclet
WellExplorer table o {1 e e e e e e e e e e e
Task (9 5
E] e Ik 2 wels: 163 [ 12 [ 21 0 Invalid.

Study taskbar —'ﬁ [ Example Study. . x

Study analysis These tools manage data at the study level (Figure 3) . The same study analysis toolbar
toolbar is accessible in all the Setup, Analysis, and Export screens. Use these tools throughout
the software workflow to:

* Analyze, save, or close a study.
* Adjust the study analysis settings.
* Access this guide (click Help).

Note: Save your studies regularly, because there is no autosave feature in
ProteinAssist software. In the study analysis toolbar, select Save or Save as.

Experiments These tools manage data at the experiment file level (Figure 3). Use the Experiments
toolbar toolbar to:

e Import experiment files into a study.

* Remove experiment files from a study.

* Generate a plate template from an experiment file.

* Apply a previously generated plate template to an experiment file.

e Export the plate settings and data in a spreadsheet-compatible format.

For further information, refer to Chapter 4.

Study taskbar Use the study taskbar at the bottom of the application window to quickly switch
between open studies and the home window (Figure 3).

Samples, Assays, These tools are located to the left of the Plate Layout tab in the Experiment Files
and Tasks lists,and  window (Figure 3) . Use these tools to view and adjust well properties in an
Well Explorer table experiment file. For further information, refer to Chapter 4.

ProteinAssist™ Software Getting Started Guide 15



2 Chapter 2 Set up ProteinAssist™ Software
Key toolbars and software conventions

Field error icon The field error icon & indicates that an experiment file is not set up properly. Hover
the pointer over the icon for information on how to correct the error.

Figure 4 Field error icon tooltip display

= @ Impaort === Remave o % Generate Plate Template b% Load Plate Template ﬁ Export @ Flate

File Name Barcode # ofYells # of Samples Instrum
& | LIMN28, tut 96 u] StepOnel
OCT4 et a5 1] StepOne

Errors for the following assays!
Target 1: Assay Target 1 must have at least one NPC welll

Assay Target 1 has no reforence sample in this study, It must have one reference assigned for the shudy.
~

There are errors for 96 wells,
Flease examine the wells and fix the errors.
5| Click Analyze fo update the error list
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CHAPTER 3

Set up a study

Overview

To set up a study:

1. Launch a study one of the following ways (page 19):
* Create a new study
* Open an existing study

* Transfer a ProteinAssist’ " Software-compatible study file (*.1as) into the
application workspace

2. Set the study properties (page 19)
3. (Optional) Manage study assays (page 21)
4. (Optional) Manage study samples (page 22)

Tutorial overview

Several files with example data are included with ProteinAssist Software (Table 4 on
page 18). You can use these files in structured tutorial exercises that are included at key
places in this guide.

The example data represents what might be seen in a study to examine the effects of an
inducer and an inhibitor of expression of the pluripotency markers OCT3/4, LIN28,
and SOX2 in an experimental cell line.

Figure 5 on page 18 illustrates the layout for each reaction plate in the example study.

 Each plate has one TagMan® Protein Assay: hLIN28, hOCT3/4, or hSOX2.
¢ Each plate has the following samples:

— 1 reference sample for that assay (no treatment).

— 2 samples that were treated with inducer.

— 1 sample that was treated with inhibitor.
* The dilution factor for the samples depends on the assay:

- LIN28: 3-fold

- OCT4: 2-fold

- SOX2: 3-fold

ProteinAssist™ Software Getting Started Guide 17



3 Chapter 3 Set up a study
Tutorial overview

Figure 5 Example Study v2.0 plate layout

Task: Unknown Unknown Reference Unknown

Treatment:  Inducer Inducer Control Inhibitor
Sample: Sample1 Sample2 Sample3 Sample4
000000000 O Q)
00000000000
000000000000

biiin | |19 QOO OGO OO OO O
000000 OOGOOO0O
GICICICICICICICICIOIOI®)
vy[OOOOOOOOOOOO
Task: NPC\O O O O O O OO O OO )

Table 4 lists the example data files that are installed by the software at C:\ Applied
Biosystems\ Protein Assist Software\ User Data\ examples.

Table 4 Example data files provided with ProteinAssist™ Software

File Description

Use

Example Study v2.0.las A complete study file with
data that is already set up
for analysis in the

In the tutorial, the study file is
transferred into the application
workspace (see page 23).

You can use this ready-made study
to explore features of the software.

software.
LIN28 v2.0.txt Plate files that contain Cy
data from the
0CT4v2.0.6d StepOnePlus™instrument
SO0X2 v2.0.txt software.

Template_LIN28 v2.0.lpt ' Template files for the
Template_OCT4 v2.0.lpt corresponding .txt files.
Template_SOX2 v2.0.lpt

In the tutorial, each plate file will
be imported into ProteinAssist™
Software and set up as an
experiment file that includes other
well property assignments.

" You can apply the template files to

the corresponding .txt files in
ProteinAssist™ Software to quickly
generate experiment files that are
ready for analysis (see page 39).

-or -

Follow the structured tutorial
exercises to:

e Set up the LIN28 experiment
file with the LIN28 template file
(page 39).

e Set up the OCT4 (page 34) and
SOX2 (page 40) experiment files
using other ProteinAssist™
Software tools.

The structured tutorial exercises
create a study, Tutorial_Study, that
is identical to Example Study v2.0
after the experiment files have
been set up for analysis.

18 ProteinAssist™ Software Getting Started Guide



Chapter 3 3
Launch a study

Launch a study
Launch a study in one of the following ways.

Create a study In the Home window toolbar, select Create Study. The Setup » Properties window
automatically opens.

Open a study In the Home window toolbar, highlight a study in the list, then click Open Study. The
Setup » Properties window automatically opens.

Transfer a study ProteinAssist Software stores studies as internal files in the application workspace.

into Protein ASSiStTM These internal files are not accessible to users. The Transfer in/out Study tools allow

Software study files to be shared outside of the application workspace (such as, by e-mail) in a
ProteinAssist Software-compatible format. Study files are first transferred out of the
application workspace (using the Transfer out Study tool) and saved as independent
files with a .las file extension (see page 55).

To access a study file that was created in another ProteinAssist Software application:
1. In Home window toolbar, select Transfer in Study.
2. Navigate to the location of your saved study file (*.las).
3. Select the file, then click Open to transfer in the files.
4

. Highlight the study in the studies list, then click Open Study. The Setup »
Properties window automatically opens.

Set study properties

The following steps, illustrated in Figure 6 on page 20, describe how to set the study
properties for newly created studies.

1. In the Study Workflow menu, click Setup » Properties to open the study
properties window.

2. Enter the values in the property fields or select the appropriate option. These
properties are required:
¢ Study Name
* Reference Use
Table 5 on page 20 describes all the study properties available through the study
properties window.
3. In the study analysis toolbar, select Save.

The study is saved in the application workspace. It can be accessed through the
Home window.

ProteinAssist™ Software Getting Started Guide 19



3 Chapter 3 Set up a study
Set study properties

Figure 6 Study Properties window

»* ProteinAssist™ Software Version 1.1

Fle Analysis Tools Help
3 -—E—Eﬂ Save EH Save as Se Close » Analyze Bnalysis Settings e Help
Edit Study Properties
g ——
1

~
— Setlp

Input Quantity Unit:
- (Exarmnple: cells/well or pg/mL)

Experiment Files

Lidy Mame (*): |Examp|a Stutdy vi.0 ‘ Description:

Custom Fields Comments: it

Ent title for tom fields. (B les: S: le Si S le T
assays < Enter a title for custom fiskds. (Examples: Sample Source; Sample Type) ~

Custam 1 Feld Mame: |Cuslum1 ‘

Samples

Custom 2 Field Name: |Cuslnm 2 ‘

Custom 3 Field Marne: |Cu5mm 3 ‘

Reference Use

& Per Flate: Each assay must have a reference sample in the same plate.

 Per Study: Each assay must have one reference sample per study;
it can be in a separate plate from the unknown or NPC samples,

Study Contents
Mumber of Experiments in Study:
Nurnber of Assays used in Study:
Mumnber of Assays available:
MNumber of Samples used in Study:
Nurnber of Samples available:

aom o owow

History
Creation Date:  2010-06-10 07:58:38 COT ]
Last Modified Date:  2010-08-10 16:37:11 COT

Iy v

Table 5 Study properties

Property or field Entry

Study Name (required) Enter a name for the study, maximum 100 characters.

The study name is incorporated into the default name(s) for
files created by the Export and Transfer out Study
functions.

Input Quantity Unit (optional] | Enter the units describing the concentration of your
samples.

The input quantity units display in the data plots and at other
points in the software.

Reference Use (required) Select the reference sample use for data analysis.

e Per Plate: Each assay must have a reference sample
assigned in the same plate.

e Per Study: Each assay must have a reference sample
assigned, but it can be in a different plate within the same
study.
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Property or field Entry
Custom Field Names Enter custom field names that you may need to manage your
(optional) studies, maximum 30 characters.

Note: Custom field names cannot be empty. If you do not
assign custom field names, leave the default values
(Custom 1, etc.) in the fields.

Example: Set a custom field name of “Time.” When you set
up the experiment files, enter the time associated with each
sample in this custom field.

Note: Custom field values are sorted as text. Enter time
values in a format that can be sorted as text. For example,
Day_01, Day_05, Day_10, etc.

Description (optional Enter a short description of the study, maximum 160
characters. The description displays in the study list in the
Home window.

Comments (optional) Enter comments, then select Add.

The software records the comments and the date and time
you added the comments. The Comments field allows you to
enter detailed information about the study (for example,
observations about the data, reasons why you made specific
decisions, and so on).

IMPORTANT! After you select Add, the comment is
permanently recorded in the study (that is, the comment
cannot be modified or removed).

(Optional) Manage assays

You can manage assays as described in this section, or when you set up the experiment
files, described in Chapter 4.

In the Study Workflow menu, click Assays to open the Assays window, shown in
Figure 7. The six assays commercially available from Applied Biosystems are
preloaded for your convenience. Table 6 on page 22 describes the assay management
features of the software.

Figure 7 Assays window

.\”T:’ = == Add == Remove
et
AL setup Mame Calor # ofWells
Properties hCSTE ~|0
hICaM1 |0
Experiment Files hLIN=E V|96
hMANOG |0
W-__ | hoCT3/4 w |96
hsSOx2 w | 06
Samples
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Table 6 Assays management

To...

Action

Add new assays

Click Add and type the new assay name.

Change the color of an assay [the assay color
is displayed in the Plate Layout tab)

Select from the Color drop-down menu.

Remove assays that are not used in the
study.

Select the assay (ctrl-click or shift-click to
select multiple assays) and click Remove.
Assays in use cannot be removed.

(Optional) Manage samples

22

You can manage samples as described in this section, or when you set up the

experiment files, described in Chapter 4.

In the Study Workflow menu, click Samples to open the Samples window, shown in
Figure 8. Table 7 describes the samples management features of the software.

Figure 8 Samples window

Samples
&~
ﬁ\ﬁ' || | e A -Fen
A
=g Setup Marne Caolor Group Treatment Custom 1 Custormn 2 Custormn 3 # oftiells
Properties NPT v 36
sample 1 w induicer 63
Experiment Files sample 2 v inducer 63
sample 3 v control 63
Assays sample 4 v inhibitor 63
Samples
Table 7 Samples management
To... Action

Add new samples.

Change the color of a sample (displayed in
the Plate Layout tab and in the Linear Range
plots).

Click Add and type the new sample name.

Select from the drop-down menu.

Edit Group, Treatment, or Custom properties
for a sample.

Remove samples that are not used in the
study.

Double-click in the field of interest for that
sample and edit its value.

Note: When the sample is assigned to wells
in an experiment file, Group, Treatment, or
Custom properties associated with that
sample are automatically assigned to the
wells.

Select the sample [ctrl-click or shift-click to
select multiple samples) and click Remove.
Samples in use cannot be removed.
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Tutorial: transfer in Example Study

To transfer in Example Study v2.0.1las, follow “Transfer a study into ProteinAssist
Software” on page 19, navigating at step 2 to:

C:\ Applied Biosystems\ ProteinAssist Software\ User Data\ examples

* The example study includes 3 experiment files, with 4 samples, and 3 assays.
e Input quantity unit is set to "cells/well."

* Reference use is set to "Per Plate," because each plate has one TagMan Protein
Assay, and the reference sample for each assay is on the plate.

Tutorial: create Tutorial_Study and set its properties

1. In the Home window toolbar, select Create Study.

2. In the Properties window, enter the following tutorial study properties:
¢ Study Name: Tutorial_Study
* Input Quantity Unit: cells/well
* Reference Use: Per Plate

3. In the study analysis toolbar, select Save.

After experiment files have been added to the study and saved, the study contents area
in the study properties window displays the number of experiment files, assays, and
samples in the study.
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Tutorial: create Tutorial_Study and set its properties
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Overview

CHAPTER 4

Set up experiment files

After you have launched a study, set up experiment files for analysis as follows.

1. Import TagMan® Protein Assay experiment files from your real-time PCR
instrument software (page 25).

2. Assign required and optional properties to the wells in each experiment file.
* Required properties: sample, assay, input quantity, and task.

» ProteinAssist’" Software provides a number of flexible tools for assigning
well properties:

— Well Editor (page 30)

— Dilution tool (page 33)

— Plate Templates (page 37)

— Copy and Paste tools (page 37)

— Samples, Assays, and Tasks lists (page 38)
— Well Explorer tool (page 38)

Note: Save your studies regularly, because there is no autosave feature in
ProteinAssist software. In the study analysis toolbar, select Save or Save as.

In the tutorial exercises, the example experiment files provided with the software,
LIN28, OCT4, and SOX2, are set up for analysis, each using a different set of
ProteinAssist Software tools.

Import experiment files into a study

About importing
experiment files

In ProteinAssist " Software, an experiment file contains TagMan Protein Assay data
from a single reaction plate, and it is equivalent to a real-time PCR instrument plate
file. This guide uses the term experiment file. ProteinAssist Software is compatible with
real-time PCR instrument experiment files as described in Table 2 on page 10. For some
real-time PCR instruments, the experiment file may include sample name, input
quantity, or assay name, in addition to the Cr values.

¢ Only .eds, .txt or .csv files can be imported.

¢ Each experiment file must have a unique name.

IMPORTANT! Changing the content of .txt or .csv files before importing them into
ProteinAssist Software may prevent importing the files, or it may result in incorrect
analysis in ProteinAssist Software.
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Import experiment Figure 9 illustrates the following procedure for importing experiment files.

files 1. Launch a study, then click Setup » Experiment Files in the Study Workflow
menu to open the Experiment Files window.

2. In the Experiments toolbar, click Import and navigate to the file(s) to be imported.

3. In the Import dialog window, select the appropriate file type from the drop-down
menu, select the file name(s) and click Import.

Note: Ctrl- or shift-click to select and import multiple files.

Figure 9 Experiments Files window and toolbar

Experlmems toolbar = = Import === Remove ﬂ% Generate Plate Template ﬂ% Load Plate Template iﬁ Export e Flate Setup Help

File Name Barcode # ofWiells # of SBamples Instrument Type i Block Type Run
LINZE v2.0.txt 95 ] StepOnePlus™ System 95 A
QCT4 v2.0.tut 95 ] StepOnePlus™ System a5 A
SOX2 w2 0. tut =[] L] StepOnePlus™ System =[] A

-_—

Tutorial:import the In the Home window, open Tutorial_Study.

LIN28, OCT4, and
S0X2 experiment
files

N

In the Study Workflow menu, click Setup » Experiment Files.

3. In the Experiments toolbar (see Figure 9), click Import and navigate to
C:\ Applied Biosystems\ Protein Assist Software\ User Data\ examples.

4. In the Import dialog window, ctrl-click to select LIN28 v2.0.txt, OCT4 v2.0.txt,
and SOX2 v2.0.txt, then click Import.

Look in: |@ examples V| 505 |E||

_5. Mame Size| Twpe Date Mo

- =] LiNzEw2.0 10KE Text Document 8126201
"SY Recentt 5] OCT4v2.0 9KE Text Document 8/26i201
euments EGNI v 9KB TextDocument 8/26/201

S
v I
-

My Documents

@

My Computer

< | 4

File name:  ["LINZEv2.0.64 OCT4v2 OB "SOX2v2 00t | [ Import |

Iy Metwork )
Places Files of type: |AII supported files (*.cov, *eds, *bd) v|

About viewing experiment files and selecting wells

Experiment files can be viewed as a plate layout or as a table.
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Figure 10 on page 27 shows an example of a plate layout grid. Outlier wells are flagged
with a red triangle; to exclude outliers from data analysis, see “Omit outlier wells” on
page 51. Table 8 on page 27 describes the tools available in the Plate Layout toolbar for

View data in the
Plate Layout tab

changing the display and data in the plate layout view.

Figure 10 Plate Layout view
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Table 8 Plate Layout toolbar

Tool

Description

Show in Wells

Show in Wells =

Select Wells

Select Wells -

e Select data to show or hide in the wells.
¢ Differentiate samples or assays by color; or choose to have no
color-coded display in the wells.

Select wells by well property: assay, sample, task, group,
treatment, or custom property.

View Legend

Displays the well legend in the plate layout grid.

Dilution

Dilution: 2.00

Omit or include wells
from data analysis

Automatically creates a dilution series from an initial input
quantity. See page 33.

For selected wells, click to omit from or include in data analysis.

Note: Omitted wells are designated with a cross in the plate
layout grid and a * in the well table. See also page 51.

Save as Image

||_°: Save as Image

Saves the plate layout grid as an image file. See Table 7 on page
22.

Clear

o, Clear

Full Screen

Zoom in or out

Clears the properties of the selected well, excluding Ct value.

Expands the plate layout grid to the screen size. Click the icon
again to reset.

Step-zooms in or out of the plate layout grid view.

Fit plate

Fits the plate layout grid in the current window.
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About selecting In the Plate Layout tab, select wells in one of the following ways. See also Figure 10 on
wells in the Plate page 27.

Layout tab Table 9 Selecting wells in the Plate Layout tab

To select... Action

One or more wells Click-drag through the desired wells.

Note: When you click-drag to select multiple wells,
ensure that the selection arrow & not the cross-hair
icon & is displayed. (The cross-hair icon indicates you
are using the Dilution tool, not selecting wells.)

An entire row Click A, B, C,....H

2
([ hoc... [@hoc.. [

T 2204 Cm 2199 Cm

g |ICTREENEE CTaemnl CT:

An entire column Click 1, 2, 3,.....12

hc

THREE

The entire plate

View data in the Click the Well Table tab to view the data and properties associated with the experiment

Well Table tab file in a flexible table format, as shown in Figure 11. Outlier wells are flagged with a *.
Table 10 on page 29 describes useful features of the well table and tasks that can be
performed in the Well Table tab, including manual omission of outlier wells.

Figure 11 Well Table view

Show in Table ~ Select Wels ~ Group by ® g
| # Wiell  Omit  Outliers  Sample Assay Task Input Quantity  CT #vg. (1 Cr5td. Dev. | Crlower CIB Cr Upper CIB | ACT Awg, ACT | ACT Std. Dev
1 AL sample 1 RSOX2  Umknown 500 2383 2354 031 22,76 24.31 489 5,18 031 L]
2 A2 sample 1 hSOX2  Unknown 500 2357 2354 031 22,76 24,31 515 518 031
3 A3 sample 1 hSOX2  Unknown 500 2321 2354 031 22,76 24,31 551 518 031
4 A4 sample 2 hSOX2 Unknown SO0 24.87 2470 0.18 24.26 2313 385 402 012
3 AS sample 2 hSOX2  Unknown 500 2471 24.70 0.18 24.26 2313 400 402 0.1
=] A6 sample 2 hSOX2  Unknown 500 24.52 2470 0.18 24.26 25.13 4.20 4.02 0.1
7 A7 sample 3 hSOXZ2  Refersnce 500 25456 2561 0.17 25.20 26.02 F28 81 017
8 A8 sample 3 hSOX2  Refersnce 500 2579 2561 0.17 25.20 26.02 293 311 017
9 A3 sample 3 hSOX2  Reference 500 2558 2561 0.17 25.20 26.02 b e o 017
10 A10 sample 4 HSOX2  Unknown 500 27.10 26.94 0.19 26,45 27.42 162 178 0.19
Sf11 A1l sample 4 HSOX2  Unknown 500 26,72 26.94 518 26,45 27.42 200 178 019
|12 Al2 sample 4 HSOX2  Unknown 500 26,99 26.94 0.19 26,45 27.42 173 178 019
13 BL sample 1 RSOX2  Umknown 250 2396 23.69 0.24 23.09 24.28 476 503 0.24
14 B2 sample 1 RSOX2  Umknown 250 2361 23.69 024 23.09 24.28 510 503 0.24
15 B3 sample 1 RSOX2  Umknown 250 2350 23.69 024 23.09 24.28 522 503 0.24
16 B4 sample 2 hSOX2  Unknown 250 25,06 24.99 0.07 24.83 2516 366 372 0.07
17 Bs sample 2 hSOX2 Unknown 250 24,99 24.99 007 24.82 2516 372 372 0.07
12 B6 sample 2 hSOX2 Unknown 250 24,93 24.99 007 24.82 2516 379 372 0.07
19 EB7 sample 3 hSOX2 Reference 250 23.84 2601 0.16 25.63 2640 288 270 0.16
20 B2 sample 3 hSOXZ2  Refersnce 250 26,14 26.01 0.16 25.63 26.40 258 270 0.16
21 B9 sample 3 hSOXZ2  Refersnce 250 26.07 26.01 0.16 25.63 26.40 265 270 0.16
22 Bi0D sample 4 hSOX2  Unknown 250 27.06 27.03 0.08 26.83 27.24 165 168 0.08
23 Bi1 sample 4 HSOXZ2  Unknown 250 26,94 27.03 o008 26,83 27.24 177 168 0.08
24 B12 sample 4 HSOXZ2  Unknown 250 27.10 27.03 o0.08 26,83 27.24 162 168 0.08
e o | sample 1 HSOX2  Unknown 125 24.84 2455 026 2592 2518 387 416 026
26 2 sample 1 RSOX2  Umknown 125 2438 2455 026 23.92 25.18 434 416 0.26
27 3 sample 1 RSOX2  Umknown 125 2443 24.55 0.26 23.92 2518 429 416 0.26 ~|
< 2
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Table 10 Well Table tools

To... Action
Hide or reveal columns Click the Show in Table drop-down menu in the Well Table
tab toolbar and select or deselect the desired fields.
Select all rows with the same | Click the Select Wells drop-down menu in the Well Table
well property tab toolbar and select a property.

Select Wells |-

Group rows by a well property | 1. Click the Group by drop-down menu in the Well Table
tab toolbar and select a well property.

2. Select Expand All or Collapse All to expand or collapse
the groups.

|+ Expand AII| = Caollapse Alll

Sort the data Click the column header of interest.

With each click, the sort toggles through ascending (shown),
descending, and none.

Perform multiple sorts Click the first column header of interest, then ctrl-click the
next column header of interest. Continue the sort by ctrl-
clicking each column header of interest.

In the example below, the table was sorted in this order:
Sample (descending), Assay, Input Quantity (descending).

Sample™! | Assay “2| Task Input Quantity ™3|
Re-order the columns " Click a column header and drag it to a new location in the
table.
Omit or include a well from Right-click the well, then select Omit or Include. Click
data analysis Analyze in the study analysis toolbar to re-analyze the
study.
47 D11 * I

Copy

it [:

Include

To omit multiple outlier wells, click the Outliers column
heading to sort the wells by outlier status, ctrl-click or shift-
click to select all the outliers (flagged with a *], right-click
and select Omit. Click Analyze as above.

Tutorial: Further Open Example Study v2.0, and use the expand/collapse and resize tools (Figure 12 on
exploration of data  Page 30) to change the display of the Experiments list and Plate Setup window in the

views Experiment Files window.
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Figure 12 Experiment Files window: expand/collapse and resize tools

s Import | s Remove ﬂ% Generate Plate Template 'ﬂ% Load Plate Ternplate ﬁ Export. @ Pl
File Mame Barcode # ofells #of Samples Instrume
0CT4 96 5 StepOne
LIN28 96 S StepOne
S0x2 96 S StepOne

]
~ A
Samples ————(all ¢[| plate Layout
] >
29 | [show in Table - Select wells - Group by -
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O [sarple 4 2 A2 sample 1 hOCT3/4 L
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4 A4 sample 2 hOCTZ/4 L
S AS sample 2 hOCTZ/4 L
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. 7 a7 sample 3 hOCT3/4 R
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m o 9 A9 sample 3 hOCT3/4 R
—] 10 A0 sample 4 hOCTZ/4 1
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o = e "

Assign well properties

About assigning
well properties

30

Experiment files from the instrument software are incomplete for analysis. All
experiment files within a study must be assigned with required well properties, and
they must follow the analysis rules in order for analysis to proceed.

Note: Save your studies regularly, because there is no autosave feature in
ProteinAssist software. In the study analysis toolbar, select Save or Save as.
Analysis rules

These analysis rules can also be accessed by clicking Plate Setup Help in the
Experiments toolbar. | [£Z] piate setup Help

® The study must have wells to analyze. It does not support cases where all wells
are omitted.

¢ All included wells must have Sample, Assay, Task and Input Quantity specified.

* Each assay-sample combination must be assigned with only one task, either
"Unknown," "Reference,”" or "NPC."

¢ Each assay-sample combination with a task assignment of “Unknown” must be
unique across the study.

e Every assay-sample combination must have at least two input quantities.

* Every experiment file must have at least one NPC well for each assay assigned in
the experiment.

* Every assay must have at least one unknown sample.

* If Reference Use is Per Study: Every assay must have one reference sample, but it
can be in a different experiment file within the same study.

¢ If Reference Use is Per Plate: Every assay must have one reference sample in the
same experiment file.
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Assign well 1. In the Study Workflow menu, click Setup » Experiment Files, and select an
properties using experiment file from the list of imported files.
the Well Editor 2. In the Plate Layout tab, select a single well, or click-drag to select multiple wells.

3. Right-click to access the well menu (Figure 13, left) and select Edit Well(s) display
the Well Editor (Figure 13, right).

(You can also access the Well Editor for a single well by selecting the well and
either double-clicking the mouse or pressing the Enter key.)

Figure 13 Well menu and Well Editor tool
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4. Enter values into the required fields: Sample, Input Quantity, Task, and Assay.
See Table 11.

5. (Optional) Assign other properties to samples for sorting and display purposes
(Table 11).

a. Click Show in Wells in the Plate Layout toolbar, and select one or more of
the following optional fields: Group, Treatment, Custom 1, Custom 2,
Custom 3. The selected field(s) appear in each well and in the edit well
window.

b. Select wells and enter the field values as described in steps 2 through 4.

6. Select Done to exit the Well Editor and save the well assignments.

ProteinAssist™ Software Getting Started Guide 31



Chapter 4 Set up experiment files
Assign well properties

Table 11 Entering well property values using the Well Editor tool

Well Property

To Assign a Value...

Notes

Sample (required)

Input Quantity
(required)

Enter a new sample name.
_Or_

Select a sample name from the drop-down
menu.

" Enter a numeric input quantity for the sample.

Sample names are imported from the
instrument experiment files if sample names
were assigned within the instrument software.

Sample names automatically appear in the
Samples list to the left of the Plate Layout tab
after you enter a new sample name or import
an instrument experiment file with pre-
assigned sample names.

Note: A sample includes all the TagMan
Protein Assay wells in the dilution series for
one cell lysate. If you assigned multiple
sample names in the instrument software (for
instance, one sample name per well), re-
assign a single sample name to the
appropriate wells in the ProteinAssist™
Software, and delete the unused sample
names. See Troubleshooting starting on
page 59 for further information.

Input values will be imported if quantity values
were assigned within the instrument software.

At least two different input quantities are
required per sample/assay combination.

Task (required)

Assay (required)

Group (optional)

Select Reference, Unknown, or NPC.

' Select an assay from the drop down menu.
_Or_

Enter a new assay name.

' Enter the value.

Reference: A reference sample is required for
each assay, and it is assigned per plate or per
study (see Table 5 on page 20.

Unknown: Test sample.

NPC: No Protein Control. There must be at
least one NPC per assay per plate.

Note: When you assign NPC, the well is
automatically assigned a sample name of NPC
and an input quantity of 0. Other well
properties are cleared.

Target names are imported as Assays from
instrument experiment files if target names
were assigned within the instrument software.

Assay names automatically appear in the
Assays list to the left of the Plate Layout tab
after you enter a new assay name or import an
experiment file with pre-assigned target
names.

ProteinAssist™ Software has é assays pre-
loaded for your convenience: hCSTB, hICAM1,
hLIN28, hNANOG, hOCT3/4, and hSOX2

This property is useful for describing variables
such as sample handling or source.

Treatment (optional)

Enter the value.

Examples: inducer, inhibitor, none.

32
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Well Property To Assign a Value... Notes
Custom 1, 2, 3 Enter the value. To rename Custom 1, Custom 2 and Custom 3,
(optional) go to Setup » Properties and enter a new
name.

Note: Custom field names cannot be empty. If
you do not assign custom field names, leave
the default values (Custom 1, etc.) in the fields.

Note: If you are using a custom field for time,
enter time values in a format that can be
sorted as text. For example, Day_01, Day_05,

Day_10, etc.
Set up a dilution You can use the Dilution tool to set up a dilution series after the highest Input Quantity
series with the (and optionally other well properties) has been assigned to the well(s), as described

below and in Figure 14. This tool is similar to a click-and-drag autofill function in

Dilution tool spreadsheet software.

1. Enter the desired dilution factor in the Dilution field of the Plate Layout toolbar.
2. Select one or more wells.

3. Hover the pointer over the lower right corner of the selected well(s) until the
dilution tool crosshair appears. Drag the crosshair to include all the wells of the
dilution series. The input quantity from the first well, row, or column selected is
reduced by the dilution factor in each succeeding well, and other well properties,
excluding Cr value, from the first well, row, or column are copied into the selected
wells.

IMPORTANT! The Dilution tool copies other well properties (except Ct value)
from the first well, row, or column into the selected wells, overwriting previous
well property assignments.

In the example shown in Figure 14, row A was selected, then the Dilution tool was
used to create the dilution series for all wells through row G.

Figure 14 Create a dilution series with the Dilution tool
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Tutorial: set up the OCT4 experiment file using the Well Editor and Dilution tool

Tutorial: set up the OCT4 experiment file using the Well Editor

and Dilution tool

This tutorial exercise demonstrates two ways to use the Well Editor and Dilution tool
to set up an experiment file.

Use the Well Editor to assign all well properties for samples 1 and 2.

Use the Well Editor to assign the well properties to the first well in the dilution
series for samples 3 and 4, then use the Dilution tool to assign the well properties
to the rest of the wells in each dilution series.

. Assign the assay.

a. Open Tutorial_Study, click Setup » Experiment Files, then select OCT4 v2.0
from the list of imported files.

The Plate Layout tab for the OCT4 experiment file displays. This experiment
file initially has only the Cy value assigned for each well.

b. Assign the hOCT3/4 assay to all the wells: select all the wells in the plate
layout, right-click and select Edit Well(s) to access the Well Editor, and select
hOCT3/4 in the Assay drop-down menu. (Do not assign other well
properties.)

2. Adjust the plate layout view. Click Show in Wells in the Plate Layout toolbar

34

(Figure 15 on page 34), and:

* Select Treatment so that it appears in the Well Editor window.

* Select Sample Color to display sample assignments by color.

Figure 15 Show in Wells tool
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Tutorial: set up the OCT4 experiment file using the Well Editor and Dilution tool

3. Use the Well Editor to assign all the well properties for samples 1 and 2 as
described in the following table: select the indicated wells, right-click and select
Edit Well(s), then enter the values as described in the following table. See

Figure 13 on page 31.
Well Property Value
Sample e Columns 1-3, rows A-G: Sample 1

e Columns 4-6, rows A-G: Sample 2

Input Quantity e Columns 1-6, row A only: 500
e Columns 1-6, row B only: 167
e Columns 1-6, row C only: 55.7
e Columns 1-6, row D only: 18.6
e Columns 1-6, row E only: 6.2
e Columns 1-6, row F only: 2.07
e Columns 1-6, row G only: 0.69

Task Columns 1-6, rows A-G (samples 1 and 2): Unknown

Treatment Columns 1-6, rows A-G (samples 1 and 2): inducer

4. Use the Well Editor to assign all the well properties for samples 3 and 4, including
input quantity, to the first wells in the dilution series, as described below. See

Figure 13 on page 31.
Well Property Value
Sample e Columns 7-9, row A only: Sample 3

e Columns 10-12, row A only: Sample 4

Input Quantity Columns 7-12, row A only: 500

Task e Sample 3 (columns 7-9), row A only: Reference
e Sample 4 (columns 10-12), row A only: Unknown

Treatment e Sample 3 (columns 7-9), row A only: control
e Sample 4 (columns 10-12), row A only: inhibitor

5. Use the Dilution tool to simultaneously assign the input quantities and copy the
other well properties to the rest of the wells for samples 3 and 4. See Figure 14 on
page 33.

a. In the Dilution field of the Plate Layout toolbar, enter: 3.
b. Select row A for samples 3 and 4 only (columns 7-12; Input Quantity = 500).

c. Hover the pointer over the lower right corner of the selected wells until the
Dilution tool crosshair appears. Drag the crosshair down to include rows A
through G.

The Input Quantity is reduced by the dilution factor, and other properties
(excluding Cy value) are copied, when you use the Dilution tool. In this way, the
well properties for samples 3 and 4 are assigned to rows B through G.

6. Set up the NPC samples: select row H (all columns), right-click to access the Well
Editor, and select NPC from the Task drop-down menu.

When a well is assigned the task NPC in the Well Editor, it is automatically
assigned a sample name of NPC and an input quantity of 0.
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Tutorial: Further exploration of the Plate Layout tab

Result After you have completed assigning the well properties to the OCT4 experiment file,
the plate layout grid should resemble Figure 16:

Figure 16 Tutorial_Study: OCT4 plate setup
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Tutorial: Further exploration of the Plate Layout tab

Use the Select Wells tool to select wells by well property (Figure 17).
Figure 17 Select Wells tool

Iiiiwl Well Table [

Show in Wells - |Select wells ~| B Wiew Legend Diluti
I Assay 3 :
! ! Sarnple 4 | I NPT
ample 1
FDD gl Task 4 sample 1
A m Gioup 4 sample 2
CT
b . Treatment  » sample 3
Custom 1 »
sample 1 sample 4
250 = Custom 2k =l
o [CIREH | orcn: » G [

36 ProteinAssist™ Software Getting Started Guide



Chapter 4 4
[Optional] Alternate methods for assigning well properties

(Optional) Alternate methods for assigning well properties

Use a plate Use a previously generated plate template to assign well properties for the entire plate.
template This feature is useful when your studies use the same plate layout from experiment to
experiment. Refer to page 42 for information about generating plate templates.

1. Select Setup » Experiment Files, select an experiment file from the list, and click
Load Plate Template in the Experiments toolbar.

You can select multiple files with ctrl-click or shift-click.

Experiments toolbar = = Import == Remove ﬂé Generate Plate Template ‘ﬂ% Load Plate Template @ Export @ Plate Setup Help

File Mame Barcode # ofWells # of Samples Instrument Type i Block Type Run
LIN=8 v2.0.txt 96 = StepOnePlus™ Systerm 95 R
OCT4 v2,0.1xt 96 2 StepOnePlus™ System 96 RS
SOX2 v2.0.txt o6 S StepOnePlus™ Systemn [=/s) [

2. In the dialog window, select a plate template (*.1pt) and click Load.

Use the Copy and Use the Copy and Paste tools in the well menu to copy all well properties, excluding

Paste tools Cr values, from one or more wells into other wells. You can also use these tools to copy
properties from some or all of the wells in one plate to a different (or new) plate. This
feature is similar to copy and paste functions in spreadsheet software.

1. In the Plate Layout tab, select the wells to be copied.
2. Right-click to access the well menu and select Copy.
3. Select the top-left well of the desired wells to copy to, right-click, and select Paste.

Figure 18 shows the properties from wells A-1 through G-1 being copied to wells A-2

through G-2.
Figure 18 Copy from multiple wells to multiple wells
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Use the Fill Use the Fill Column and Fill Row tools to copy the properties of the selected well,
Column and Fill excluding Cy value, and paste them into the remaining wells in the column or row.
Row tools In the Plate Layout tab, right-click the selected well, then select Fill Column or Fill

Row from the drop-down well menu.
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Figure 19 Fill Column and Fill Row tools

1 H
ample 1 arnple 1
00 el |00 el
&
T 2 Edit wel(s)
sample 1 Copy
167 Paste
E
2 Y Fill Calumn
inducer Fill R
sample 1 = -
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lists

Use the Samples, Assays, or Tasks lists, located to the left of the Plate Layout tab, to
assign these corresponding well properties to selected wells. Use the up/down arrows
to expand/collapse the lists, and the icon to move the list displays up/down
(Figure 20).

® The Samples and Assays lists are populated when sample or assay assignments
are made, using any tool, to any of the experiment files in a study.

* Group, treatment, or custom properties that have been assigned to a sample are
automatically assigned to wells when that sample is assigned.

1. Select one or more wells.

2. Check the box next to the sample name, assay name, or task in the appropriate
list.

In the example shown in Figure 20, wells A-1 through G-3 have been selected and
assigned “sample 1” from the Samples list.

Figure 20 Assign well properties using the Samples, Assays, or Tasks lists
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Use the Well
Explorer tool

For an individual well, all well properties except well location, task, and Cy value can be
changed using the Well Explorer tool, located to the left of the Plate Layout tab.

1. Select a single well. The assigned properties are displayed in the Well Explorer.

Use the up/down arrow to expand/collapse the Well Explorer, and the
icon to move the Well Explorer up/down.
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2. Click the value for the property to be changed. If a property is editable, the value
is highlighted.

3. Enter the value in the field. If you enter new values for sample and assay names,
the Samples and Assays lists are updated.

In the example shown in Figure 21, all the well properties for well B-1 are editable
except the well location, task, and Cy value.

Figure 21 Assign well properties using Well Explorer
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Tutorial: Set up the LIN28 experiment file with a plate template

1. Open Tutorial_Study, click Setup » Experiment Files, and select LIN28 v2.0 from
the list of imported files.

The Plate Layout tab for the LIN28 experiment file displays. This experiment file
initially has only the Ct value assigned for each well.

2. Click Load Plate Template in the Experiments toolbar.

3. In the Load window, navigate to C:\ Applied Biosystems\ Protein Assist
Software\ User Data\ examples, select Template_LIN28 v2.0.1pt, and click Load.

4. Click Show in Wells in the Plate Layout toolbar (Figure 15 on page 34), and:
a. Select Treatment so that it appears in the Well Editor window.

b. Select Sample Color to display sample assignments by color.
5. Click Save in the Study Analysis toolbar.
The Plate Layout tab should look like Figure 22 on page 40.
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Figure 22 Tutorial_Study: LIN28 experiment file setup
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Tutorial: Set up the SOX2 experiment file with other tools

In this exercise, you use the Well Explorer, Copy and Paste tools, Dilution tool, and
Samples, Assays, and Tasks lists to set up the SOX2 experiment file.

Note: Before proceeding with this tutorial, complete the tutorial exercise for OCT4 on
page 34 or LIN28 on page 39, to populate the Samples, Assays, and Tasks lists.

1. Open Tutorial_Study, click Setup » Experiment Files, and select SOX2 v2.0 from
the list of imported files.

The Plate Layout tab for the SOX2 experiment file displays. This experiment file
initially has only the Ct value assigned for each well, and a default task
assignment “Unknown.”

2. Click Show in Wells in the Plate Layout toolbar (Figure 15 on page 34), and:
a. Select Treatment so that it appears in the Well Editor window.

b. Select Sample Color to display sample assignments by color.

3. Assign the assay to all wells: click the top left corner of the plate layout grid to
select all the wells, and check hSOX2 in the Assays list.

4. Assign the initial input quantities in each dilution series using Well Explorer and
copy/paste:
a. In the plate layout grid, select well A-1.
b. In the Well Explorer tool, enter 500 in the Input Quantity field.
c. Right-click well A-1 and select Copy in the drop-down menu.
d

. Select wells 2-12 in row A, right-click and select Paste. The input quantity is
copied to the rest of the row.

5. Assign input quantities to the rest of the wells using the Dilution tool. (Do this
before assigning other well properties.)

a. In the Dilution field, enter 3.
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Tutorial: Set up the SOX2 experiment file with other tools

b. Select row A (click A), hover the pointer in the bottom-right corner of the
selected wells to activate the dilution cross-hair, and drag the cross-hair

down through row G. See Figure 14 on page 33.

The input quantities are reduced by the dilution factor in series and assigned
to the rest of the wells. Refer to “Set up a dilution series with the Dilution

tool” on page 33).

6. Using the Samples list, assign samples to wells as shown in the following table.

The Treatment field is automatically populated with the sample assignment.

Wells Sample Treatment
Columns 1-3, rows A-G Sample 1 inducer
Columns 4-6, rows A-G Sample 2 inducer
Columns 7-9, rows A-G Sample 3 control
Columns 10-12, rows A-G Sample 4 inhibitor

7. Assign the task using the Tasks list.

a. Select all Sample 3 wells (columns 7-9, rows A-G), and select Reference

from the Tasks list.

b. Select row H (all columns), and select NPC from the Tasks list.

8. Click Save in the Study Analysis toolbar.

When you are done, the plate layout grid should look like Figure 23:

Figure 23 Tutorial_Study: SOX2 experiment file setup
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(Optional] Generate plate template

(Optional) Generate plate template

After the well properties have been assigned, you can save the plate configuration as a
plate template.

It is possible to generate a template without one or more of the required properties
(such as Sample).

1. In the Experiments toolbar, click Generate Plate Template.

2. Enter a file name, navigate to the desired save location, then click Generate to
save the new template.
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CHAPTER 5

5 Analyze a study

Overview

After the mandatory well properties have been assigned (sample name, assay name,
task, and input quantity) to each experiment file in the study, following the analysis
rules, the study is ready for analysis. Refer also to “Analysis rules” on page 30 for
guidelines for assigning well properties.

1. Click Analysis in the Study Workflow menu.

The software automatically calculates the fold change of the test samples with
respect to the reference sample(s). The fold change algorithm corrects for
background ligation in the absence of protein (ACy) and factors in the linear range
of each sample dilution series. For further information, see Appendix A on page
61.

2. Review the data for each dilution series in the Linear Range tool (starting on
page 44).
¢ Review the ACr plot for all the samples
* (Optional) Change the data and tooltips displayed in the ACy plot
¢ View the analysis results in table format
¢ View the Cy data for troubleshooting purposes

3. Adjust the analysis settings (optional), omit outliers, if desired, and re-analyze the
study (starting on page 48).

* Review and adjust the Linear Range
¢ Change the settings for outlier detection
e  Omit outliers, if desired

4. Review the fold change results (starting on page 52).
* View the fold change results as a bar graph

* View the fold change results as a heat map

Note: If the experiment files have not been set up correctly, an error message appears
when you click Analysis. See “Troubleshooting” on page 59. Field error icons are
cleared only after a study is successfully re-analyzed after you have corrected setup
errors.

Note for tutorial: After you complete the tutorial exercises in Chapters 3 and 4,
Tutorial_Study should be set up for data analysis. Alternatively, you can simply use
Example Study v2.0, which is already set up for analysis, to help you explore the
software analysis features (see “Tutorial: transfer in Example Study” on page 23).
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5 Chapter 5 Analyze a study
Review the dilution series data in the Linear Range tool

Review the dilution series data in the Linear Range tool

Review the ACt plot

44

1. Select Analysis » Linear Range » ACt Plot tab.

2. In the ACy Plot toolbar, select an assay from the drop-down Assay menu to view
the ACry results for that assay.

Figure 24 shows the ACy plot and sample table for the hLIN28 assay in Example Study
v2.0.

Figure 24 Linear Range tool: ACt plot tab and sample table
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In the ACy plot, the ACy and average ACt values for each sample-assay combination
are plotted against the input quantities. In Figure 25, a portion of the ACy plot has been
enlarged to show an example of each of the data point styles.

* ACy=average NPC Cy - sample Cr (solid colored circles)

* Average ACy = average NPC Cy — average sample Cr (solid triangles)

* NPC ACy = average NPC Cy — NPC Cy (open black circles)

e Average NPC ACy = average NPC Cr — average NPC Cy (= 0; solid colored
triangles)
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Figure 25 ACy plot: data point styles
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Review the dilution series data in the Linear Range tool
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Change the data
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1. In the ACt Plot toolbar, click Zoom In.

2. Click-drag around a region to enlarge.

Figure 26 Zoom In tool
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Click Show in the ACy plot toolbar and select the desired items from the drop-down
menu to show in the ACy plot:

Figure 27 Show data in ACt plot
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5 Chapter 5 Analyze a study
Review the dilution series data in the Linear Range tool

Change the tooltips Click Tooltips in the ACt Plot toolbar and select the desired well properties from the

displayed in the drop-down menu to show as tooltips in the ACt plot:
ACy plot Figure 28 Show tooltips in the ACq plot
Linear Range
§ ACT Plot
Tooltips :1}
z Sample
z Task
z Input Cuankity
[#] 2er
z Experiment
Z Location of well

Review the sample  The sample table, located below the ACy plot (see Figure 24 on page 44), lists all the
table data and properties associated with each sample, as described in Table 12. Table 13 on
page 47 describes useful tools for viewing data in the Sample Table tab.

Table 12 Key sample table columns

Column headingl(s) Description

Slope, Intercept, R2 Values for the slope, intercept and R of the regression line for each
sample.

Fold Change Fold change value for each sample-assay combination.

e The fold change is automatically calculated for each sample with
task assigned as Unknown.

e The fold change for samples assigned as Reference is N/A.

¢ In some cases the fold change is reported as "Undetermined.”
See “Software rules for the fold change algorithm” on page 64.

Fold Change Lower/ Lower and upper 95 % confidence interval boundaries, of the fold

Upper CIB change value.

Min. and Max. Input The minimum and maximum input quantity values of the linear
range.

Linear Range Linear range for this sample-assay combination was determined
by:

e Automatic setting
e Manual setting

e Unknown: the linear range algorithm failed to find a linear
range. See “Troubleshooting” on page 59.

Task, Group, Properties assigned to the sample-assay combination.
Treatment, Custom

4Lb ProteinAssist™ Software Getting Started Guide



(Optional) Review
the Ct plot

Review the dilution series data in the Linear Range tool

Chapter 5

Table 13 Linear Range: tools for viewing data in the sample table

To...

Action

Sort the data in each column

Click on the column header.

Resize the columns

Hover the pointer between two _column
headings until the resize arrow <+ appears,
then drag the arrow.

Hide or show columns

Change the order of columns

Click Show in Table in the sample table
toolbar, and select or deselect the fields in
the drop-down menu.

Click-drag the column header.

Display or remove the sample ACt curve
from the ACy plot

Check or uncheck the box in the Show
column.

The Cy plot is useful for viewing the plotted NPC and uncorrected Cr values, for
troubleshooting purposes. The Ct and average Cr values for each sample/assay
combination are plotted against the input quantities.

e (g values: solid circles
* Average Cy values: triangles
¢ NPC Cy: open black circles

e Average NPC Cy values: solid colored triangles

Note: You can change the data and tooltips displayed in the Ct plot in the same way as

for the ACt plot (see page 45).
Figure 29 C; Plot tab
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5 Chapter 5 Analyze a study
(Optional] Adjust the analysis settings and reanalyze the data

(Optional) Adjust the analysis settings and reanalyze the data

Review the linear When you click Analysis in the Analysis toolbar, ProteinAssist Software automatically
determines a set of data for each sample that follows a linear relationship between
log(input quantity) and ACry. This set of data is used in the relative quantification (fold
change) calculation. The zone encompassing the upper and lower boundaries of the
data set is called the linear range.

* The linear range is displayed on the AC plot as a gray zone (see Figure 30).

* For each sample, a dotted line shows the regression line for that set of data.

¢ When you open the ACy plot the first time for each study, the regression line and
linear range for the reference sample are displayed.

e To display the linear range for a sample-assay combination, click the sample-
assay combination in the sample table below the plot, or click the plot of the

sample-assay combination.

range

Figure 30 Displaying the linear range for a sample-assay combination
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[Optional] Manual_l_y the following procedure describes how to manually adjust the data set used the

set the linear calculate the regression line for a given assay-sample combination. Figure 31 on page

49 illustrates an example of an adjustment to the linear range so that it better reflects

range of one or . : L e PR -
the transition region of the sigmoidal dilution curve. See “Linear range algorithm” on

more samples page 62 for further information.

1. Click the sample curve of interest in the ACt plot or the sample row(s) in the table
below the ACt plot. The linear range for that sample displays as a gray zone.

2. Click-drag the left or right bar to adjust the upper and lower boundaries of the
linear range.

3. Click Analyze in the toolbar for reanalysis.
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Chapter 5 5
(Optional] Adjust the analysis settings and reanalyze the data

Figure 31 Linear Range: viewing and adjusting the linear range

Click-drag

ACT

02 05 1 2 3 4 & 10 20 30 100 200
Input Quantity (cells/wel)

l

ACT

50 |
(Optional) Adjust The sensitivity of the linear range algorithm is the degree to which the average ACt
the Linear Range values of replicate groups must be colinear. The following procedure describes how to

adjust the sensitivity for all samples in a given study while viewing the ACy plot.
Adjusting the sensitivity within a study overrides the default set for the software
under Tools » Preferences (Table 3 on page 13).

Detection setting

1. Click Analysis Settings in the Study Analysis toolbar.

2. Adjust the sensitivity of the algorithm with the slide tool (Figure 32 on page 50;
default setting is 20):

* High sensitivity: A replicate group is considered part of the linear range
only if its average ACr value falls very close to the regression line of an initial
set of two or three replicate groups chosen by the algorithm.

* Low sensitivity: A replicate group can be considered part of the linear range
even though its average ACt value deviates significantly from the regression
line of an initial set of two or three replicate groups chosen by the algorithm.

3. Click OK. The software automatically performs a re-analysis with the new
setting(s).
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5 Chapter 5 Analyze a study
(Optional] Adjust the analysis settings and reanalyze the data

Figure 32 Adjusting the Linear Range Detection setting

x|
Outlier Detection
Loy 3 High
Sensitivity: 1
(standard deviations) | | f |
5 4 3 2

Linear Range Detection
Loy 20 High
Sensitivity: — |_
| 1 1 1 |
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[8]4 | Cancel | Reset to Defaults |

Tutorial: explore 1. Create a copy of a study, to explore adjustments to the data analysis settings: open
adjustments to Tutorial_Study or Example Study v2.0, click Save as in the study analysis toolbar,
linear range and enter a new file name.

2. Click Analysis » Linear Range and select an assay of interest for display in the
ACy plot tab.

3. Select the Reference sample plot (highlight the Reference sample in the sample
table), drag the lower boundary of the linear range to include one or more
additional data points, and observe the new regression line in the ACt plot.

4. Click Analyze in the Study Analysis toolbar, and observe the change in Fold
Change values for the other samples in the study in the sample table.

tiona eview e Quantification Threshold is shown on the A ot as a horizontal dashed line
Optional] Revi The Quantification Threshold is sh he ACy pl hori 1 dashed li
the Quantification (Figure 33). The Quantification Threshold:

Threshold e Isafactor used in the calculation for the fold change between the Unknown and
Reference samples. See Appendix A on page 61.

¢ Has a default value of 2.0.

Improved accuracy of fold change values can be achieved by calibrating the
Quantification Threshold as described in Appendix B on page 67.

Figure 33 ACy Plot: Quantification Threshold
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Chapter 5 5
(Optional] Adjust the analysis settings and reanalyze the data

(0 ptional_] Adju st Outliers are automatically detected by ProteinAssist Software, and the individual
Outlier Detection wells are flagged on the AC plot as open triang]es.
setting Note: Flagged outliers are included in data analysis unless they are manually omitted,

as described in “Omit outlier wells”, below.

It can be useful to adjust the Outlier Detection setting for the study while viewing the
ACy plot:

1. Click Analysis Settings in the Study Analysis toolbar.

2. Adjust the settings:
* The lower the sensitivity, the more an individual well must deviate from its
replicate group’s average Cy value to be named an outlier.
* Set the standard deviations from the average of replicate Ct values; default is
3 standard deviations.

3. Click OK. The software automatically performs a re-analysis with the new
setting(s).

Figure 34 Adjusting the Outlier Detection setting
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Omit outlier wells Flagged outlier wells are included in data analysis unless they are manually excluded
using the Omit tool. You can omit outlier wells in the following ways:

In the ACt plot (illustrated in Figure 35 on page 52):
1. In the ACy Plot toolbar, click Zoom In.
2. Click-drag around a region to enlarge (facilitates selecting outlier data points).

3. Select the outlier data point (open triangle) and:
* Omit the data point: right-click on the outlier and select Omit.

¢ Include an omitted data point: right-click on the data point and select
Include.

4. Click Analyze in the study analysis toolbar to re-analyze the study.
In the Cy plot: follow the analogous procedure described above.

In the Setup » Experiment Files » Well Table tab (to omit all outliers in one batch): as
described in Table 10 on page 29.

Note: A well with no Cy, C1240, or C1<0 is automatically omitted by the software and
it cannot be included.
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5 Chapter 5 Analyze a study
View the fold change results as a bar graph

Figure 35 Omit/Include outlier wells
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View the fold change results as a bar graph

1. In the Study Workflow menu, click Analysis » Fold Change.

The fold change values for each sample-assay combination are displayed as a bar
graph and as a table (Figure 36).

2. (Optional) Adjust the display of the bar graph as described in Table 14.
Figure 36 Fold change results: bar graph
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Table 14 Adjusting the fold change bar graph or sample table views

To... Action

Change the fold change scale (Y-axis) In the Fold Change toolbar: select Log, (default),
Log g, or Linear from the Type drop-down menu.

Show or hide the 95% confidence In the Fold Change toolbar: check or uncheck
intervals of the fold change results in Show confidence.

the bar graph [¥] Show confidence |
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Chapter 5
View the fold change results as a heat map

To...

Action

Group the data in the bar graph by an
additional well property (the software
automatically groups the results by
assay)

Show or hide a sample-assay
combination in the bar graph

In the Fold Change toolbar: select a well property
from the Group by drop-down menu.

Group by: |Treatment |44

Graup

Treatment
Custom 1
Custom 2
Custom 3

The property displays below the graph.

In the sample table: check or uncheck the box in
the Show column.

Show or hide a well property or analysis
result in the sample table

In the sample table: click Show in Table and
check or uncheck the property or result in the
drop-down menu.

Show in Table

|

#

Show

Sample

Assay

Fold Change {logz)

Fold Change Lower CIE {logz)
Fold Change Upper CIE {logz)
Calar

Group

Treatment

Custom 1

Custom 2

s I < <] <]

Custom 3

Note: The fold change algorithm reports results in the range 10 to 10°. For fold
change values outside this range, the bar displays a break, and the fold change values
are reported in the sample table as follows:

Fold change scale

Fold change <10-¢

Fold change >10¢

Log,

Logqg
Linear

<-20 >20
<-b >6
0.0 >1,000,000

View the fold change results as a heat map

The heat map display is useful when there are many assays and samples.

1. In the Study Workflow menu, select Analysis » Heat Map (Figure 37 on page 54).

2. (Optional) Adjust the display of the heat map as described in Table 15 on page 54.
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Chapter 5 Analyze a study
View the fold change results as a heat map

Figure 37 Fold change results: heat map view
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Table 15 Adjusting the fold change heat map view

To...

Action

Sort the data by one or more properties, in
ascending order

Change the fold change scale

Step zoom infout

Click Specify Sort, then select one or more
sample properties in the Specify Sort Order
window.

)

I @ Specify Sort Order
sl :1 Specify Sort

Sort 1: - ¥

Sort 2: Sample

Sort 3: oo

Gort 4; |Custom 1
Custam 2
Saort 5; [Custom 3

Select Log, (default) or Logyg.
®Llog, Ology,

Click Zoom In or Zoom Out.

Restore the view to the default size

Click Default Size.

Default Size

Note: The fold change algorithm reports results in the range 10~ to 10°. For fold
change values outside this range, the sample color displays at the maximum value,

reported on the heat map scale as follows:

Fold change scale | Fold change <10-¢

Fold change >108

Log, <-20
Logg <=6

>20
>6
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CHAPTER 6

Save or export study data

Study data can be exported or saved in a variety of formats, as described in Table 16.

Table 16 Save and export options for study data

To... File type Menu commands

Save the plate layout grid as an image file *.pdf Setup » Experiment Files » Plate Layout
*.png tab » Save as Image
*Jpg

Save the ACy plot as an image file *.pdf Analysis » Linear Range » ACy Plot tab » Save as
*.png Image
*Jpg

Save the Cy plot as an image file *.pdf Analysis » Linear Range » C; Plot tab » Save as
*.png Image
*.Jpg

Save the Fold Change bar graph as an image file *.pdf Analysis » Fold Change » Save as Image
*.png
*Jpg

Save the Fold Change heat map as an image file *.pdf Analysis » Heat Map » Save as Image
*.png
*.Jpg

Save the study in the application workspace

Accessible only

through the

Study analysis toolbar » Save or Save as

application
Save a study to a location outside the application *.las " See “Transfer out a study” below.
workspace, in ProteinAssist™ Software-
compatible format
Export the selected plate setup (includes well * txt Setup » Experiment Files » Export
properties and Cy datal *.csv
Export the study data for analysis outside the *.txt See “Export study data” on page 56.
ProteinAssist Software *.csv

Transfer out a study

The software stores studies as internal files in the application workspace. These
internal files are not accessible to users. The Transfer out Study function allows you to
move a study out of the ProteinAssist Software workspace, in a ProteinAssist
Software-compatible format, to enable sharing with another user or for backup.
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Chapter 6 Save or export study data
Export study data

1. In the Home window, select the study of interest, then click Transfer out Study.

rg Create Study | Open Study r@ Transfer out Study 543 Transfer in Study 3 Delete Stud
\ O \ 2w

Study Name Description
Exarnple Study v1.0 |

i
T berial S T

2. Browse to a save location, enter a name for the study file (*.las), then click Save.

If an existing study file has the same name as the study you are transferring out,
you will be asked if you want to overwrite the existing file.

IMPORTANT! If you overwrite the existing study file, all the information in the
existing study file will be lost.

3. (Optional) After you have transferred out a study, you can share the study file
with another user (for example, by e-mail). That user must then transfer in the
study file to his or her application workspace. This process is described in
“Transfer a study into ProteinAssist’ Software” on page 19.

(Optional) Delete a  You can delete a study from the application workspace, without deleting the

study

corresponding study file that has been transferred outside the application workspace
as a *las file.

In the Home window toolbar, select the study to be deleted, then click Delete Study.

Export study data

About exporting The Export tool transfers study data to a file compatible with downstream software
study data such as Microsoft® Excel® software.

Each study is organized into two types of data for export.

* Well properties and data: properties and data that can be individually assigned
to a well, including Cy and ACy values, corresponding average values, standard
deviation, and 95% confidence intervals for replicates.

¢ Fold change results: linear range and fold change data for each sample, as well as
relevant sample properties.

Export a study Figure 38 on page 57 illustrates the following procedure for exporting a study.

56

1. In the Study Workflow menu, click Export » Export.

2. Choose an export option.

¢ Single File: the well properties and data and the fold change results are
exported to a single file.

* Separate Files: the well properties and data are exported to one file, and the
fold change results are exported to a separate file. For each export file, follow
the rest of this procedure.

3. Set the location of the exported file: accept the default location, or select Browse to
navigate to the desired save location.

4. Set the name and format of the exported file:

ProteinAssist™ Software Getting Started Guide



Chapter 6
Export study data

a. (Optional) Modify the default file name, if desired. The default file name is:
StudyName_yyyymmdd_hhmmss_Tables

where
e StudyName is the name of the current study
* yyyymmdd and hhmmss are the current date and time

b. Select the file type from the pulldown menu. Both file types are compatible
with a spreadsheet application such as Microsoft Excel software.

e *txt: tab-delimited text file

* *.csv: comma-separated value file
5. Select the data to be exported.
a. Under the Properties & Data tab, check the data to be exported.
b. Under the Fold Change Results tab, check the data to be exported.

6. Check/uncheck Open after exporting, then select Export.

If Open after exporting has been selected, the software will open a *.txt file in a
text editing program, and it will attempt to open a *.csv file in your default
spreadsheet software.

Figure 38 Exporting study results
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Open and view the 1. Right-click the exported file, then select Open With » Microsoft Office Excel to
exported files view the contents as a spreadsheet.

2. Use the AutoFit function in Excel software to make the data easier to view.
a. Click in the upper-left corner of the spreadsheet to select all cells.

b. Select Format » Column » AutoFit Selection.
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Export study data
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CHAPTER 7

Troubleshooting

Observation

Possible cause

Recommended action

Hundreds of sample names
display in the Samples list.

Custom field names or field
values are truncated.

The software alerts you that
only visible text is stored.

The PCR instrument plate file has one
sample name assigned per well.

ProteinAssist™ Software truncates
field values that exceed the maximum
length allowed.

1. Assign one sample name to all the wells in
each dilution series. Refer to “Assign well
properties” starting on page 30.

2. Delete the unused sample names:

In Setup » Samples, select the sample
names to be deleted (ctrl-click or shift-
click), then click Remove.

. Adjust the entry so that all text is visible.

Atypical data is displayed in
wells or samples.

You are unable to edit well
properties using the Well
Explorer tool.

Contaminated wells or samples.

Repeat the TagMan® Protein Assays with
fresh reagents. Refer to TagMan® Protein
Assays Sample Prep and Assay Protocol.

Instrument is not correctly calibrated.

Incorrectly labeled wells or samples.

More than one well is selected. (The
Well Explorer tool can only be used to
edit one well's properties.)

You are trying to change an uneditable
property. (The Well Explorer tool
cannot be used to change the well
location, Cy value, or Task.)

Make sure your instruments are appropriately
maintained and calibrated. Refer to the user

guide for your instrument.

Correct the well or sample property.

Use the Well Editor to edit properties for
multiple wells. See page 31.

. Use the Well Editor or Tasks list to change a

well's Task assignment.

The Cy value or well location cannot be
changed.

Inadvertent change to well
property.

Wells were selected with the Dilution
tool instead of the selection tool.

Incorrect well property for an NPC
sample was assigned after NPC task
or sample assignment.

Ensure that the correct cursor is displayed
when selecting wells. Refer to Table 9 on page
28.

. When the NPC sample or task is assigned, the

input quantity is set to 0 and other well
properties are cleared.

Assign the NPC task or sample to a well after
all other properties have been assigned, so
that the well properties are reset
appropriately.
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Chapter 7 Troubleshooting

Observation

Possible cause

Recommended action

The study fails to analyze, and
a field error icon appears in
the plate layout grid or in the
experiment files list.

Error(s) in experiment file(s) setup.

Hover the pointer over the field error icon for
information to correct the setup.

Below are some common setup corrections.
See also “Analysis rules” on page 30.

e Make sure that the correct Reference Use
is selected in the Edit Study Property
screen:

- Per Plate: Each assay must have a
reference sample assigned in the same
plate.

- Per Study: Each assay must have a
reference sample assigned, but it can be
in a different plate within the same
study.

e Make sure that each plate has at least one
no-protein control (NPC) assigned per
assay.

e Make sure that each assay-sample
combination is assigned a task, either
"Unknown,"” "Reference,” or "NPC."

e Make sure that each assay-sample
combination with a task assignment of
“Unknown” is unique across the study.

e Make sure that every assay has at least one
unknown sample.

The linear range column on
the sample table has a value
“Unknown.”

Fold change for a sample is
“Undetermined.”

Software fails to open, and the
following error message
displays: "JVM terminated. Exit
code=1..."

The slope of the regression line within
the linear range is <0.1.

| All the values for ACy for that sample
are <0.5.

If the slope is <0.1 because of low
concentration of the target protein, prepare
new lysates with a higher concentration of
cells, and repeat the TagMan® Protein Assays.

See also “Software rules for the fold change

algorithm™ on page 64.

If ACy values are <0.5 because of low
concentration of the target protein, prepare
new lysates with a higher concentration of
cells, and repeat the TaqMan® Protein
Assays.

The fold change confidence interval is
infinite.

Intermittent Java Runtime error.

¢ Review the linear range.

e Omit outliers from data analysis.

¢ See also “Software rules for the fold
change algorithm” on page 64.

Click OK, then open the software again.
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APPENDIX A

Supplemental information

About TagMan® Protein Assays

3' oligo

TagMan® Protein Assay reagents enable detection and relative quantitation of protein
targets in mammalian cell culture samples using an adapted form of PLA™, a
proximity ligation assay technology, in combination with real-time PCR (Figure 39).

In the TagMan Protein Assay procedure, total protein cell lysates are prepared, and a
dilution series of each lysate is incubated with paired assay probes. These probes
consist of antibodies for the protein of interest conjugated to 5' and 3' oligonucleotides.
The ends of the oligonucleotides are brought into proximity when the antibody
components of the assay probe pair concurrently bind to two different epitopes on the
target protein. A bridge structure can then form by hybridization of a third
oligonucleotide to the assay probe oligonucleotide ends. This structure is captured
through ligation, and the ligation product is then amplified and detected by TagMan
real-time PCR. For further information, see the TagMan® Protein Assays Chemistry
Guide (PN 4405780) and the TugMan® Protein Assays Sample Prep and Assay Protocol
(PN4449283).

Figure 39 TagMan® Protein Assays: proximity ligation with real-time PCR

Binding Ligation Real-time PCR

/ H High concentration

l Intermediate concentration

B Low concentration
Background

5' oligo

Target ’

[9)]
Fluorescence

-

arget arget
Cycle number

Key features of TagMan® Protein Assay data analysis

The Ct data from TagMan® Protein Assays reflect not only the real-time PCR but also
the assay probe binding and ligation events. Therefore relative quantification of
protein targets with TagMan Protein Assays uses a different approach from relative
quantification of mRNA or DNA targets via traditional real-time PCR.
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Appendix A
Linear range algorithm

Key features of TagMan Protein Assay data analysis:

* (Cp values are normalized to cell count or total protein concentration, because no
suitable endogenous controls are currently available.

¢ Cgpvalues from buffer-only control samples (no-protein control samples; NPC)
that are run on the same plate are used to correct for background ligation that
occurs in the absence of protein. The Cy value corrected for background ligation is
called ACr.

¢ A dilution series of each sample (cell lysate) is assayed, and the linear range
within this series is identified and used to estimate the quantity of target protein
in the sample relative to the quantity of this protein contained by a reference
sample.

For example, in a drug or chemical treatment study, the reference sample could be
untreated cells; for a time course study, time-zero cells.

¢ The differences in the slope and intercept of the regression lines for the samples
are incorporated into the fold change algorithm, to account for the differences in
assay efficiencies associated with the protein-antibody binding dynamics.

“Fold change algorithm” on page 62 gives a detailed description of the algorithm.

Linear range algorithm

ProteinAssist Software automatically selects a set of data for each sample that follows a
linear relationship between log(input quantity) and ACt. The zone encompassing the
upper and lower boundaries of the data set is called the linear range. The slope and
intercept of the regression line through points encompassed by the linear range
interval are key parameters in the fold change algorithm (see “Fold change algorithm”
following).

In general, a plot of TagMan Protein Assay ACy values vs log(input quantity) for a
dilution series forms a sigmoidal curve. The appropriate linear region of this curve to
include for the purposes of estimating fold change is the transition region, the interval
over which the sigmoid moves from low ACy to high ACt values.

Figure 31 on page 49 illustrates an example of an adjustment to the linear range so that
it better reflects the transition region.

Fold change algorithm

The fold-change estimate is intended to estimate the amount of a target protein
contained in a target sample relative to that contained in a reference sample. It is
applicable to situations where the amount of target protein per cell cannot be
determined but the exact number of cells or the total protein concentration can be
determined.

Linear regression is applied to data from the linear regions of the dilution curves for
the unknown and reference samples. These operations yield slopes and intercepts for
each of the samples, A, 1, By, A and B, respectively. The fold change estimate is
given by the following equation:
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Fold change
confidence interval

Setting the
Quantification
Threshold

Appendix A
Fold change algorithm

F — b (Bunk_QT)/Aunk_(Bre_/'_QT)/Amff

where Qr is the quantification threshold value that you have chosen and b is the base
of the logarithm used to transform the input quantity and, hence, the base of the
logarithm used in the linear regression operation. The equation is based on an
exponential model relating protein quantity to the production of ligation product
coupled with the governing equation relating fluorescence and the quantity of ligation
product fed into the PCR.

The validity of the fold-change estimate relies on the following key assumptions:

* When cell count is used to normalize the data, it is assumed that the average per-
cell content of the target protein is a reasonable value to characterize the per-cell
content over the sample of cells processed; that is, the distribution of per-cell
protein content is assumed monomodal over the population of cells analyzed.

* The spontaneous formation of ligation product in the absence of the target protein
is independent of the context of molecular structures associated with the protein
in its natural state (e.g., cellular debris when examining target protein content in a
cell of interest). In other words, it is assumed that the characteristics of the
spontaneous formation of ligation product is completely captured by examining
the case where no cells are input to the assay, the NPC as described for this
product.

* The value of Q7 is appropriate for the unknown and reference samples.

* In the case where references and/or unknown samples are spread across two or
more plates, it is assumed that the NPC also accounts for the major factors
underlying plate-to-plate variability.

The 95 % confidence interval for the fold change estimate is obtained by combining the
standard confidence intervals (95 %) for the linear regressions performed on the
reference and unknown data within their respective linear ranges.

The nature of the confidence interval calculation is such that, for studies with multiple
experiment files and one reference sample (Reference Use is Per Study), the confidence
interval estimate will be more accurate if the reference sample replicates are spread out
across the plates.

If the slopes of the reference and unknown samples are equal in the linear range (that
is, the curves are parallel in this region), then the value of Qr, the Quantification
Threshold, has no impact because it drops out of the fold change calculation above.

If the slopes for the samples are not equal, the most accurate fold change calculations
are achieved by determining the appropriate value of the Quantification Threshold
empirically, as described in “Calibrate the Quantification Threshold” on page 67. Use
the default Quantification Threshold setting for experiments where the Quantification
Threshold has not been empirically determined.
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Appendix A

Upgrade conversions of pre-release data

Software rules for
the fold change
algorithm

Upgrade conversions of pre-release data

64

If...

Then...

The quantification threshold line does not
intersect the 95 % confidence bounds of the
regression line for either the reference
sample, the unknown sample, or both.

(This can happen for data with a high
variance or a low number of data points.)

Valid confidence intervals are not generated.

The fold change confidence interval upper
and lower boundary values display
“Undetermined.”

The fold change value displays
“Undetermined.”

The maijority of the points in each dilution
group are <0.5 ACy.

The maijority of the points in each dilution
group are <0.5 ACy but at least one dilution
point has a majority of replicates >0.5 ACy.

The determined slope for a given sample is
<0.1.

The linear range is set manually.

The fold change value displays
“Undetermined.”

The slope, intercept, fold change value, and
confidence interval boundaries are
calculated and displayed.

» The slope and intercept display “N/A.”

e The fold change value and confidence
interval boundaries display
“Undetermined.”

e The Linear Range column
(Analysis » Linear Range » sample
table) displays "Unknown".

e The 0.1 slope limit does not apply.
e The 0.5 ACy rules do apply.

The first time you open a study from the pre-release version of ProteinAssist Software,
you receive a prompt to re-analyze the study. Click OK.

Information

‘fou are opening a study saved from a previous version,
Opening this study will upgrade it ko the current version,
Re-analysis is required,

X

When the pre-release data is re-analyzed, the following conversions make the pre-
release data compatible with the upgraded software.

¢ The Linear Range Detection sensitivity is set to 20 %.

To see the setting, go to Study Analysis toolbar » Analysis Settings.

¢ The contents of the pre-release time field are moved to an unused custom field.
(Refer also to the entry for custom fields in Table 5 on page 20.)

* Analysis results are cleared.

¢ Manual linear range settings are retained.

e Samples with task assignments of “NPC” are assigned “NPC” as sample name.
* Samples with names of “NPC” are assigned the task “NPC.”
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Related documentation

Appendix A
Related documentation

Title (Part Number)

Description

TagMan® Protein Assays Sample Prep and
Assay Protocol (PN 4449283)

Procedures for sample prep and relative
guantification experiments with TagMan®
Protein Assays reagents.

TagMan® Protein Assays Chemistry Guide
(PN 4405780)

Background and supplemental information
on TagMan® Protein Assay technology and
targeted proteins.

Obtaining support

For the latest services and support information for all locations, go to:

www.appliedbiosystems.com

At the Applied Biosystems web site, you can:

* Access worldwide telephone and fax numbers to contact Applied Biosystems

Technical Support and Sales facilities.

e Search through frequently asked questions (FAQs).

¢ Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and

other related documents.
e Download PDF documents.

¢ Obtain information about customer training.

* Download software updates and patches.
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APPENDIX B

Supplemental procedures

Calibrate the Quantification Threshold

The accuracy of fold change estimates can be improved by calibrating the
Quantification Threshold. Ideally, the calibration is performed for each distinct assay-
sample type combination. The following procedure describes how to perform the
calibration.

1. Prepare positive and negative control sample lysates for the TagMan® Protein
Assay target of interest, as described in the TagMan® Protein Assays Sample Prep
and Assay Protocol.

2. Mix positive and negative control sample lysates to generate a set of samples with
known relative amounts of target.

3. Prepare a dilution series from each mixed lysate, and perform TagMan Protein
Assays with the assay of interest, as described in the TagMan® Protein Assays
Sample Prep and Assay Protocol.

4. Setup the experiment files in ProteinAssist’ Software.

5. In Analysis » Linear Range, adjust the Quantification Threshold systematically
and compare the observed fold change results to the theoretical values. See
Figure 40 on page 68.

To adjust the Quantification Threshold setting:

a. Enter the threshold value in the ACt Plot toolbar.
or

Click-drag the horizontal dashed line and move it up or down.

b. Click Analyze in the toolbar to recalculate the plot with the new
Quantification Threshold.

The Quantification Threshold adjustment applies to all samples for that assay,
within the study.

The Quantification Threshold setting that generates fold change data that best reflects
the theoretical values should then be used for unknown samples.

In the example shown in Table 17 on page 68 and Figure 40 on page 68, NTERA2
(positive) and Raji (negative) control lysates were mixed to yield a series of lysates that
were 100%, 50%, 25%, and 10% NTERAZ2. These mixed lysates were used for hLIN28
TagMan Protein Assays. The 100% NTERA2 sample served as the reference.

Table 17 shows the observed fold change results at different Quantification Threshold
settings. In this example, Quantification Threshold settings of 2.5 or 3.0 resulted in fold
change values calculated by the software that were closest to the theoretical values
based on the proportion of NTERA2 lysate in each sample.

ProteinAssist™ Software Getting Started Guide 67



Appendix B
Use Microsoft® Excel® software to modify well properties

Figure 40 shows the dilution series for the samples at a Quantification Threshold

setting of 2.5.
Figure 40 Calibrating the Quantitation Threshold
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Table 17 Observed fold change results at various Quantification Threshold settings

) Observed Fold Change
Sample :ﬂ?éﬁ:;;; at Quantification Threshold Setting:
2.0 25 3.0
100 % N/A N/A N/A N/A
50 % 0.50 0.57 0.52 0.48
25 % 0.25 0.29 0.27 0.25
10 % 0.10 0.12 0.10 0.083

Use Microsoft® Excel® software to modify well properties
Users familiar with Microsoft Excel spreadsheet software may find it useful to modify
certain well properties in an Excel spreadsheet.
1. Select one or more wells and right-click to access the well menu. Select Copy.

2. Open ablank Excel worksheet and use the Paste function to copy the well
properties into the worksheet.

3. After making the desired edits in Excel, copy all rows and columns with data or
annotation, including column headers.

Do not modify the header cells in Excel.
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Use Microsoft® Excel® software to modify well properties

4. Right-click the top-left well of the selected group in the Plate Layout grid, and
select Paste to paste the edits for all the selected wells.
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ACy

experiment file

Export

Import

No Protein Control
(NPC)

plate file
properties

reference

task

Transfer out Study

Unknown

* csv

* las

*.Ipt

* txt

Glossary

The Cy value for a sample after correction for the NPC (no protein control) Ct
(background ligation). ACt = average NPC Cy — sample Cr.

An experiment file contains TagMan® Protein Assays data from a single reaction plate.

The Export tools export data outside the application workspace for downstream
analysis. You can export both plate setup data and analysis results.

The Import tool imports experiment files from your real-time PCR instrument software
into ProteinAssist'" Software.

TagMan® Protein Assay samples without cell lysate. The NPC samples measure the
background ligation of TagMan Protein Assays.

In the real-time PCR instrument software, a file that contains real-time PCR data from
a single reaction plate.

Data assigned to wells that are used in ProteinAssist' Software analysis.

Relative quantification (fold change) of the TaqgMan® Protein Assay targets in the
unknown samples is calculated relative to the reference sample. For example, in a time
course study, the time-zero sample could be the reference.

The role of the sample in the data analysis: NPC, Reference, or Unknown.

The Transfer out Study tool saves study data outside of the application workspace as
independent files, each with a .las file extension, for sharing or backup purposes.
These files are still compatible with ProteinAssist' " Software, using the Transfer in
Study tool.

Unknown samples are the test samples for which the relative quantification of the
TagMan® Protein Assay targets is calculated.

Comma-separated value file.

A study file that has been saved outside the application workspace using the Transfer
out Study tool.

A template file that stores plate setup properties that are used frequently.

Tab-delimited text file.
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Symbols

*las 18, 56
*Ipt 18
*txt 18

A

Add new assays 22
Add new samples 22
Adjust Quantification Threshold 67
Algorithm, fold change 62
Analysis rules 30
Analysis settings 49, 51
Assays 32

Assays list 15, 38

Change color 22
Automatic omission of data 51
Autosave (no autosave feature) 30
Average Cp 47
Average ACy 44
Average NPC Cp 47
Average NPC ACy, definition 44

Bar graph 52
Save as image 55

C

Change color
Assays 22
Samples 22
Change scale
Bar graph 52
Heat map 54
Clear well properties 27
Confidence intervals
ACrand Cp 56
Fold change 46, 52, 63

Copy/paste
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Excel® 68
Well menu 37
Create study 19
Cr Plot 47, 55
Cr, confidence interval 56
Custom fields/properties 21, 22, 33

D

Data conversion, software upgrade 64
Decimal delimiter 13
Defaults
File save location 11
Study preferences 12
Delete multiple samples 59
Delete study 56
DeltaCT/ACT 44:, 71
Confidence interval 56
DeltaCy/ACt Plot 44
Outliers 51
Quantification Threshold 50
Sample table 46
Save as image 55
Show/hide curves 47
Show/hide data 45
Tooltips 46
Dilution factor 13
Dilution series 9, 27, 33, 40, 44
Documentation, related 65

E

Error icon 16
Example data files 18
Example Study 18, 23
Expand/collapse

Index

Experiments list and Plate Setup window 29

Samples, Assays, and Tasks lists 38
Well Explorer 38

Experiment files 71
Analysis rules 30
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Index

Export plate setup 55 Installation 7

Import 25, 71 Intercept, regression line 46
Experiment Files window 26

Expand/collapse and resize tools 29 K

Experiments toolbar 15
Export 71

Plate setup 55

Study data 55, 56, 57

Key features, TaqMan® Protein Assays data
analysis 61

L

F Linear Range 44, 48

Fold Change 46

Manual adjustment 48
Minimum/maximum input 46

Field error icon 16
File formats

:-CSV 71 Regression line 46, 62

Jas 18,71 Sample table 46

“lpt 18,71 Linear Range Detection setting 14, 49
*txt 18,71 & &%

Linear regression 62

Exported, saved, or transferred out data 55, 56
Load Plate Template 37, 39

File name, exported study data 56
Fill Column/Row 37

Fit plate 27 M
Fold Change 46, 48 Manage Assays 21

Algorithm 62 Manage samples 22

Confidence intervals 46 Maximum plates per study 9
Fold Change bar graph 52 Move

Save as image 55 Samples, Assays, and Tasks lists 38
Full screen Well Explorer 38

Plate layout 27 MSDSs

obtaining 65

G Multiple sorts

Generate Plate Template 42 Well Table 29

Group 22, 32
Group by property N
bar graph 53 NPC 41,71
Well Table 29 Task or sample assignment 35
NPC Cr 47
H NPC ACr, definition 44
Hardware configuration 7
Heat map 53 0
Save as image 55 Obtaining support 65
Home window toolbar 14 OCT4 experiment file 34
Omit/include 27, 29, 51
I Open study 19

Optional well properties 32

Image files, file formats 55
Outlier Detection setting 13, 51

Import experiment files 25 _
Include Wells 27 Outliers 27, 51
Input Quantity 13, 20, 32
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Plate layout 27
Copy/paste 37
Fill Column/row 37
Legend 27
Save as image 55
Select wells 28
Show well fields 13
Toolbar 27
Well Explorer 38
Plate setup 30, 55
Plate Template 37
Generate 42
Preferences
Linear Range Detection setting 49
Properties, study 19
ProteinAssist™ Software
Compatible real-time PCR systems 10
Example data files 18
Installation 7
Introduction 9
Set software preferences 11
Studies, experiment files, and samples 9
Study preferences 12
Upgrade from pre-release version 8
Workflow 11
Proximity ligation 61

Q

Quantification Threshold 14, 50, 63
Adjusting 67
Determine optimum setting 67

R

R?, regression line 46
Real-time PCR systems 10
Re-analysis
After software upgrade 7, 64
Quantification Threshold adjustment 67
Reference Use 13, 20
Regression line 48, 62
Related documentation 65
Remove assays 22
Re-order columns
Sample table 47
Well Table 29

Required well properties 32
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Resize 29
Sample table 47
Samples, Assays, and Tasks lists 38
Well Explorer 38

S

Sample table
ACrt Plot 46
Properties 46
Samples 9, 32
automatic property assignments 38
Change color 22
Samples list 15, 38, 41
Samples list, delete multiple samples 59
Save 55
Save as image 55
Plate layout 27
Save location, default 11
Save study 55
Select wells 28
By property 27, 36
Well table 29
Sensitivity
Outlier Detection setting 51
Sensitivity, Linear Range Detection 49
Settings
Quantification Threshold, optimum 67
Show in
DeltaCr/ACt Plot 45
Sample table 47
Show/hide property or data 27
Bar graph 53
Fold change sample table 53
Plate layout 34, 39
Well Table 29
Slope, regression line 46
Sort data
Heat map 54
Sample table 47
Well Table 29
Study analysis toolbar 15
Study comments field 21
Study data
save or export 55
Study description field 21
Study Name 20
Study preferences 12

Index
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Index

Study properties 20, 23
Study taskbar 15

Study workflow menu 14
Support, obtaining 65
System requirements 7

T

TagMan® Protein Assays 61
TagMan® Protein Assays
plate layout 9
plate setup 10
samples and task assignments 10
Task 9, 32, 41, 71
NPC 35, 41
Reference 71
Tasks list 15, 38
Template, plate 37
Time in custom field 33, 64
Toolbars
Experiments 15
Home 14
Study analysis 15
Transfer in Study 19, 23
Transfer out Study 55, 71
Treatment 22, 32
Troubleshooting 59
Tutorial
Copy/Paste 40
Create study 23
Dilution series 40
Example data files 18
Example Study 18, 23
Import experiment files 26
LIN28 39
Linear range setting 50
OCT4 34
Overview 17
Samples list 41
SOX2 40
Templates 39
Transfer in study 23
Tutorial_Study 23
Well Editor 41
Well Editor and Dilution tool 34
Well Explorer 40

76

U

Upgrade ProteinAssist™ Software 8

v
View exported study data 57

W

Well Editor 31, 32

Show well fields 13
Well Explorer table 15, 38
Well menu

Copy/paste 37

Fill Column/Row 37
Well properties 71

Excel® 68

Well Editor 31, 32
Well Table tab 28

y4

Zoom in/out
Heat map 54
Plate layout 27
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